Spreadsheet Assignments
Grade 9
Background Information:
1. Terminology
[image: Parts of the Excel 2010 Screen - © Ted French]

Active cell: is recognized by its black outline.  Whatever you type will always be entered into the active cell. Different cells can be made active by clicking on them with the mouse or by using the arrow keys on the keyboard.
Formula Bar: Located above the worksheet, this area displays the contents of the active cell. It can also be used for entering or editing data and formulas.
Name Box: Located next to the formula bar, the Name Box displays the cell reference or the name of the active cell. (ex. A1, B14, ZZ123, etc)
Column Letters and Row Numbers:  are used to name each cell.  This makes it easy to refer to any cell on the entire sheet by name.  The letter is always given first followed by the number.  Cell B4 for example is in the second column and the fourth row.  You will notice that when all the letters of the alphabet are used up they start repeating. After  column Z is AA and after AA is AB and After ZZ is AAA and AAB and so on.
Ribbon: is the strip of buttons and icons located above the work area. The Ribbon is organized into a series of tabs - such as File, Home, and Formulas. Each tab contains a number of related features and options.
Sheet Tabs: are separate spreadsheets that can be used IF NEEDED to link to separate parts of a common project.  Large projects may have many linked spreadsheets linked that each do the calculation of a portion of a much greater project.
2. Cell Types
Text Cell: Any data that includes alphanumeric data will cause the cell to be labelled as a text cell.  Text cells are always left justified and cannot be used as part of most formulas.
Numeric Cell: To stay a numeric cell the data in the cell can only contain numbers and mathematical symbols.  It will always be right justified.
Formula Cell: Is a numeric cell that starts with an “=” sign to signify that the cell is equal to the result of the formula that is entered.  It will always be right justified.
3. Entering Data: Entering data into worksheet cells is always a three-step process.
These steps are:
a. Click on or move to the cell where you want the data to go.
b. Type the data into the cell.
c. Press the Enter key on the keyboard OR click on another cell with the mouse OR use the arrow key to move to another cell.
4. Column Widths: By default, the width of a cell permits only eight characters of alphanumeric data entry to be displayed before that data spills over into the next cell to the right.  If the cell or cells to the right are blank, the entered data is displayed in the worksheet and spreads across multiple columns.  If the cell to the right contains any data however, the contents of the first cell are truncated to the first eight characters.  The extra data is not deleted but flows behind the column to the right and is not visible. To correct this problem so that the data is fully visible, the column containing that data needs to be widened.
NOTE: If the data is numeric it will be converted to scientific notation OR the cell will be filled with pound symbols. (ex. “########”)  The number in the cell will not be altered but this is a warning that the entire number is not being displayed.  When the numeric cell is widened sufficiently the contents will return to a correctly displayed value.
As with all Microsoft programs, there are multiple ways of widening columns. The steps below cover how to widen columns using the mouse.
Widening Individual Worksheet Columns
1) Place the mouse pointer on the line to the right of the column name in the column header.
2) The pointer will change to a double - headed arrow
3) Click and hold down the left mouse button and drag the double - headed arrow to the right to widen that column until the the desired width is reached.
4) Widen other columns to show data as needed.
Widening a Group of Worksheet Columns
a. Place the mouse pointer on the line between two of the selected columns in the column header.
b. The pointer will change to a double - headed arrow
c. Click and hold down the left mouse button and drag the double - headed arrow to the right to widen the column until the desired width for all columns in the group is reached.
d. When you let go of the mouse button all columns in the selected group will be widened to that width.

5. Formatting Cell Contents in Excel Spreadsheets
Formatting cells involves the following types of changes:
a. The format of the number/date
b. The alignment of the contents of the cell
c. The font characteristics
d. The addition/creation of borders around all or parts of the cells
e. The fill color/characteristics of the cells
f. The locking for protection from editing of some cells
6. Steps to formatting
a. Select the cell or group of cells that you want to format.  (to select a group of cell simply click on the upper left cell of the group and drag down to the lower left of an area.  The same formatting will be applied to that entire area.
b. The window shown below pops up allowing you to select the type of formatting you want to do.)
c. Click on the correct tab at the top of the box and fill in the options you want apply to the selected cell/area.
d. Fill in the options as you want them displayed.
e. Click on the “OK” button in the bottom right.
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7. Charting Spreadsheet Data
Charts are used to display series of numeric data in a graphical format to make it easier to understand large quantities of data and the relationship between different series of data.
To create a chart in Excel, you start by entering the numeric data for the chart on a worksheet. Then you can plot that data into a chart by selecting the chart type that you want to use on the Insert tab, in the Charts group.
[image: Worksheet data and chart]
1. Worksheet data
2. Chart created from worksheet data
Excel supports many types of charts to help you display data in ways that are meaningful to your audience. When you create a chart or change an existing chart, you can select from a variety of chart types (such as a column chart or a pie chart) and their subtypes (such as a stacked column chart or a pie in 3-D chart). You can also create a combination chart by using more than one chart type in your chart.
[image: Chart with formatting]
Example of a combination chart that uses a column and line chart type.
[bookmark: __toc255902070]Charts are used to display series of numeric data in a graphical format to make it easier to understand large quantities of data and the relationship between different series of data.
To create a chart in Excel, you start by entering the numeric data for the chart on a worksheet. Then you can plot that data into a chart by selecting the chart type that you want to use on the Insert tab, in the Charts group.
[image: Worksheet data and chart]
1. Worksheet data
2. Chart created from worksheet data
Excel supports many types of charts to help you display data in ways that are meaningful to your audience. When you create a chart or change an existing chart, you can select from a variety of chart types (such as a column chart or a pie chart) and their subtypes (such as a stacked column chart or a pie in 3-D chart). You can also create a combination chart by using more than one chart type in your chart.
[image: Chart with formatting]
Example of a combination chart that uses a column and line chart type.
There are many chart types available as seen in the graphic below.  Each type of chart also has a list of variations of that chart type.  
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Getting to know the elements of a chart
A chart has many elements. Some of these elements are displayed by default, others can be added as needed. You can change the display of the chart elements by moving them to other locations in the chart, resizing them, or by changing the format. You can also remove chart elements that you do not want to display.
[image: A chart and its elements]
1. The chart area of the chart.
2. The plot area of the chart.
3. The data points of the data series that are plotted in the chart.
4. The horizontal (category) and vertical (value) axis along which the data is plotted in the chart.
5. The legend of the chart.
6. A chart and axis title that you can use in the chart.
7. A data label that you can use to identify the details of a data point in a data series.
Modifying a basic chart to meet your needs
After you create a chart, you can modify any one of its elements. For example, you might want to change the way that axes are displayed, add a chart title, move or hide the legend, or display additional chart elements.
To modify a chart, you can do one or more of the following:
· Change the display of chart axes    You can specify the scale of axes and adjust the interval between the values or categories that are displayed. To make your chart easier to read, you can also add tick marks to an axis, and specify the interval at which they will appear.
· Add titles and data labels to a chart    To help clarify the information that appears in your chart, you can add a chart title, axis titles, and data labels.
· Add a legend or data table     You can show or hide a legend, change its location, or modify the legend entries. In some charts, you can also show a data table that displays the legend keys and the values that are presented in the chart.
· Apply special options for each chart type    Special lines (such as high-low lines and trendlines), bars (such as up-down bars and error bars), data markers, and other options are available for different chart types.
[bookmark: __toc255902072]Applying a predefined chart layout and chart style for a professional look
Instead of manually adding or changing chart elements or formatting the chart, you can quickly apply a predefined chart layout and chart style to your chart. Excel provides a variety of useful predefined layouts and styles. However, you can fine-tune a layout or style as needed by making manual changes to the layout and format of individual chart elements, such as the chart area, plot area, data series, or legend of the chart.
When you apply a predefined chart layout, a specific set of chart elements (such as titles, a legend, a data table, or data labels) are displayed in a specific arrangement in your chart. You can select from a variety of layouts that are provided for each chart type.
When you apply a predefined chart style, the chart is formatted based on the document theme that you have applied, so that your chart matches your organization's or your own theme colors (a set of colors), theme fonts (a set of heading and body text fonts), and theme effects (a set of lines and fill effects). 
You cannot create your own chart layouts or styles, but you can create chart templates that include the chart layout and formatting that you want.
[bookmark: __toc255902073]Adding eye-catching formatting to a chart
In addition to applying a predefined chart style, you can easily apply formatting to individual chart elements such as data markers, the chart area, the plot area, and the numbers and text in titles and labels to give your chart a custom, eye-catching look. You can apply specific shape styles and WordArt styles, and you can also format the shapes and text of chart elements manually.
To add formatting, you can use one or more of the following:
· Fill chart elements    You can use colors, textures, pictures, and gradient fills to help draw attention to specific chart elements.
· Change the outline of chart elements    You can use colors, line styles, and line weights to emphasize chart elements.
· Add special effects to chart elements    You can apply special effects, such as shadow, reflection, glow, soft edges, bevel, and 3-D rotation to chart element shapes, which gives your chart a finished look.
· Format text and numbers    You can format text and numbers in titles, labels, and text boxes on a chart as you would text and numbers on a worksheet. To make text and numbers stand out, you can even apply WordArt styles.
[bookmark: __toc255902074]Reusing charts by creating chart templates
If you want to reuse a chart that you customized to meet your needs, you can save that chart as a chart template (*.crtx) in the chart templates folder. When you create a chart, you can then apply the chart template just as you would any other built-in chart type. In fact, chart templates are custom chart types — you can also use them to change the chart type of an existing chart. If you use a specific chart template frequently, you can save it as the default chart type.


Spreadsheet Assignments
Grade 9
Spreadsheet Assignment #1 - MARKS - Part A (Making the Worksheet)
For spreadsheet assignment # 1 we are going to make a spreadsheet where we enter three marks for five subjects and it calculates the averages of those five subjects.  It will do this for term 1 and term 2 and then will give us the final mark in those subjects.  It should give us a average of each of the columns as well.  We will then create a bar chart of the three averages columns.  The steps to doing Assignment 1 are given in great detail below.  Make sure you do them in the order they are given.

1. In column A type the text shown below.  Do not worry that some of your text overlaps into column 2, we will fix that next.
[image: ] 

2. Move your mouse to the line between the Column A and Column B headings.  When the cursor changes to a double arrow (as shown below), click and drag the column just wide enough to accommodate the widest text box and let go.  Notice column A width has been changed.
[image: ]



3. Now enter the headings across Row 1 as shown below.
[image: ]

4. Now move over top of the column heading B box and click and drag to over top of the Column Heading J box.  You should have all of columns B to J highlighted as shown below.  
[image: ]

5. Now move your cursor to between Column heading B and column heading C.  When the cursor changes to the column width adjustment icon (double arrow) click and drag the column so it is a little wider than the heading.  When you let go of the mouse button you will notice that it adjusted columns B thru to J to that same width as shown below.
[image: ]

6. Now enter fictitious marks for mark 1 to 6 for each subject as shown below.
[image: ]
7. Click on cell E2 and enter the following text "=B2+C2+D2/3".  Press the enter key to accept this.  Notice that it gives you a mark that is not possible.  This is because we forgot to use brackets to signify correct order of operations.  Click on the formula in the formula bar just above the column headings bar.  Use the arrow keys and keyboard to edit the formula to the following "=(B2+C2+D2)/3".  Press the enter key to accept this.  That should give you the correct average.

8. We are now going to click on cell E3 and create a formula using the second method. Enter "=(" and then using the arrow keys move to cell B3.  Notice that it enters the cell reference for you.  Enter a "+" symbol and use the arrow keys to move to cell C3.  Enter a "+" symbol and use the arrow keys to move to cell D3.  Now enter the following text ")/3" to finish the formula.  When you press "Enter" the correct average should appear in E3.  This method is best for referring to cells in formulas to prevent mistakes.

9. Now, the third way to create formulas is to copy them and let Excel do an adjustment to the cells to autocorrect them.  This works in situations where all cell references adjust by the same amount (ex. down one row OR to the left four columns, etc.).  Right click on cell E3 where you have a formula that you have created that is correct.  In the menu thatr appears move to the copy command and click on it.  Notice that the cell is selected and you see "dancing ants" around the cell.  Now move to cell E4 and click and drag down to cell E6 to select all the cells you drag your mouse over.  With your mouse hovering over the selected group of cells right-click again.  This time click on paste and notice the formulas are pasted after correcting them for column and row shift.  (DO NOT WORRY about varying decimal points, we will format the entire worksheet later just before we are done.)

10. Now, using the same method of copying cells we just learned right-click over cell E2 and COPY.  Then click and drag from cell I2 to cell I6.  Right-click over cell I2 and PASTE. to copy that formula into all the selected cells.


11. In cell J2 create the following formula, "=(E2+I2)/2" and press enter.  Now COPY and PASTE that formula to cells J3 to J6.  This will tell you what your final mark is in all five subjects.  You worksheet should look like the one below:
[image: ]

12.  So far we have been creating our formulas from scratch.  Worksheets have thousands of formulas built in that you can automatically apply and thousands more that you can download from the Microsoft site.  To create the AVERAGE column marks we are going to use the AVERAGE FUNCTION to show you how easy it is to use automated formulas.  Click on the B7 cell and then click on the Formulas tab at the top of the screen.  Click on the AVERAGE formula and notice it puts it into the B7 cell with the cells it thinks you want to include in the average.  Usually it is correct so you just hit ENTER and the average appears.
13. Now, using the select, copy and paste options, paste that formula across ROW 7 from cell B7 to J7.
14. We are now done everything except making it look pretty.  We are going to format all the cells. 
a. First we want to format ALL number and formulas cells to round off to one decimal place.  To do this click and drag from cell B2 across and down to cell J7.  This should have all of our numeric content selected.  With the mouse hovering over the selected area right-click and from the popup box click on Format Cells.  This will bring up a box that allows you to format the number, alignment, font, border, patterns or protection.  After looking at number formatting we can do you want to select the NUMBER option in the NUMBER menu and change the Decimal Paces to "1".  Then click "OK" at the bottom right of the box.  Notice all numbers are nicely formatted to one decimal place.
b. Since numbers always are right aligned and headings are always left aligned we want to move our headings from cell B1 to J1 aligning them all to the right.  To do this select those cells and right-click choosing FORMAT CELLS.  This time click on the ALIGNMENT TAB and under HORIZONTAL click the drop down menu arrow on the right of the box and choose RIGHT(INDENT).  ".  Then click "OK" at the bottom right of the box.  Notice all headings we selected are now formatted to the right side of their respective cells.
c. Lastly we want to highlight the most important marks (Avg. 1, Avg. 2, Final). To do this click and drag from cell E1 to E6 (not E7) to select them.  Right-click and choose format cells.  Click on FONT and change FONT STYLE to BOLD.  Then click on PATTERNS and choose a light pink color.  click "OK" at the bottom right of the box.  
d. Do the same thing to cells I1 to I6 (not I7).
e. Do this again for cells J2 to J6 EXCEPT format the text to BOLD ITALICS and to a light blue.  
f. Lastly, format all text in column A to BOLD and all text in Row 1 to BOLD.
It should look as follows when you are done the worksheet part:
[image: ]

Spreadsheet #1 - Part B (Making the Chart)

For this chart we want to make a 3D Column Chart.  In order to do this we need to very carefully select the data we want included in the chart.  If we do this correctly it will automatically set everything up with all labels and a legend.
1. Click and drag from cells A1 to A6.  Then press the CTRL KEY and select cells E1 to E6.  Then press the CTRL KEY and select cells I1 to I6.  Then press the CTRL KEY and select cells J1 to J6.  Make sure you have not selected any row 7 cells because AVERAGE is not one of your subjects.
2. Now click on chart, choose a Column chart and then at the bottom a 3D Bar chart.  When you click finish the chart will pop up on your screen.  In the first sample on the next page the AVG. 2 label is missing.  This is because the chart is too small to show everything so in the second one it is there because I clicked on the corner and stretched it out bigger.  It should look like the sample on the following page.
[image: ]
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COMPLETING THE ASSIGNMENT:
a. Save the Excell document in your “My Documents” in your “Computers 9” folder, and call it “SpreadsheetAssign1RoxyBitner” (use your name instead of mine, please.
b. In your website, make 3 new pages under the “Spreadsheet” menu item.  Call them Assignment 1, Assignment 2, and Assignment 3.  These should appear as a drop-down menu.
c. Use the snipping tool to take a jpeg copy of the chart and of the table.  Insert Assignment 1 on the corresponding page under “Spreadsheets”.  Be sure to insert the title and a picture on top of the page.
This should complete your first Assignment.  Now you are ready to move on to assignments 2 and 3.









Spreadsheet Assignments #2 - TEMPERATURE

Description:  
For this assignment you are going to create a chart that lists the average temperature for each month of the year for a 10 year period starting in 2005.  We will have an averaging calculation for each year in the bottom row and an averaging formula for each month of the year in the right hand column.  All the data in this chart will be fictitious.  After you have created the worksheet with all of the data in it we will create a 3D Line Chart of the temperature data. DO NOT INCLUDE THE AVERAGES COLUMNS IN YOUR CHART.  You will then copy the worksheet and the chart to your PowerPoint portfolio to complete the assignment.
[bookmark: _GoBack]
Assignment: 
1. Create a spreadsheet that has the months of the year listed down column A and the years 2005 to 2014 listed across Row 1. 
2. Copy the data I have supplied below into the first column.  Then make up fictitious data for the remaining years by simply increasing or decreasing the months average temperature by a few degrees.  See the sample below:
[image: ] 



After creating the chart shown above and filling in all missing data do the following formatting.
a. Bold Column A and Row 1 Headings
b. Change the width of Column A so all month names fit into the cell.
c. Change the width of columns B through K so they are narrower but the text still fits into the cell leaving a little extra space.
d. Format all formula cells so the value is shown to only one decimal place.

Now create a 3D line chart and copy the data and chart to you PowerPoint.  Due to the size of this chart each will require a separate slide.


	 
	2005
	2006
	2007
	2008
	2009
	2010
	2011
	2012
	2013
	2014
	Average

	January
	-25
	-22
	-30
	-18
	-26
	-22
	-28
	-18
	-24
	-21
	-23.4

	February
	-19
	-12
	-16
	-18
	-14
	-20
	-16
	-8
	-15
	-17
	-15.5

	March
	-11
	-10
	-1
	-8
	-5
	-13
	-7
	-11
	-6
	-9
	-8.1

	April
	-1
	-3
	0
	2
	4
	-4
	-1
	-2
	2
	4
	0.1

	May
	8
	6
	10
	2
	5
	2
	6
	9
	7
	3
	5.8

	June
	18
	14
	15
	21
	18
	14
	16
	19
	23
	16
	17.4

	July
	27
	31
	24
	28
	24
	20
	24
	27
	25
	22
	25.2

	August
	22
	26
	24
	23
	21
	18
	23
	24
	19
	22
	22.2

	September
	11
	13
	7
	17
	10
	15
	17
	13
	15
	11
	12.9

	October
	2
	-3
	-5
	0
	1
	-4
	-3
	1
	-6
	-1
	-1.8

	November
	-9
	-18
	-7
	-10
	-12
	-8
	-11
	-10
	-14
	-6
	-10.5

	December
	-20
	-24
	-16
	-13
	-14
	-19
	-6
	-17
	-16
	-13
	-15.8

	Average
	0.25
	-0.17
	0.42
	2.17
	1.00
	-1.75
	1.17
	2.25
	0.83
	0.92
	0.71


Sample Worksheet (Your temperatures will vary from those shown because you are making then up.)

[image: ]
Sample Chart (NOTE: Changed my font and chart sizes so all months and years displayed)
Adding to your Website:
a. Save the Excell document in your “My Documents” in your “Computers 9” folder, and call it “SpreadsheetAssign2RoxyBitner” (use your name instead of mine, please.
b. Use the snipping tool to take a jpeg copy of the chart and of the table.  Insert Assignment 2 on the corresponding page under “Spreadsheets”.  Be sure to insert the title and a picture on top of the page.







Spreadsheet Assignments #3 - Religious Affiliation
For this assignment you will be researching the religious affiliation statistics for Canada.  Stats Canada does regular surveys of Canadians.  When you do a search for Canadian Religious Affiliation you will find some listings for the statcan website and in some of those articles you will find tables of the data for the top 10 to 12 religious affiliations in Canada.  You want to make sure you find one of the reports that gives the data from a Stats Canada Census Report.  It does not matter which year the report is for.
Put this data into a spreadsheet and create a 3d Pie Chart from it.  Make sure you properly format and label the chart. (NOTE: If you find the data in table form on the internet you can simply select, copy and paste it straight into your worksheet.  No need to do more work than you need to.)
Adding to your Website:
a. Save the Excell document in your “My Documents” in your “Computers 9” folder, and call it “SpreadsheetAssign2RoxyBitner” (use your name instead of mine, please.
b. Use the snipping tool to take a jpeg copy of the chart and of the table.  Insert Assignment 2 on the corresponding page under “Spreadsheets”.  Be sure to insert the title and a picture on top of the page.
Sample Chart Below:
[image: ]
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